
MacDraft Professional Release Notes 
 
This document contains the release notes for all versions of MacDraft after version 4.2.2. 
 
Version 6.2.1 (27th March 2018) 
 
Bug Fixes 
• Fixed an issue where grid snapping was not aligning to the grid.   
• Added a “Center Working Drawing” option in the View menu, to make it easier and faster to center the document view.   
• Fixed an issue with selected text being invisible. 
• Fixed an issue where palettes were not having their state saved. 
• Fixed an issue with text shifting in DWG files saved using MacDraft. 
• Fixed a crash issue when rotating disassembled dimensions. 
• Fixed an issue with the “Load Layer” warning displaying when attempting to open some older documents. 
• Fixed an issue when adding guides with a position. 
• Fixed Export PDF... to now allow transparent backgrounds. 
• Fixed Export PDF... so that it doesn’t include items in the gray space. 
• Fixed an issue where certain DWG files were not opening 
• Fixed other smaller performance related issues. 
• Fixed various issues with localized versions. 
• Fixed an issue where the line weights panel was empty. 
• Fixed crash issues when adding library items to the document, by rewriting the library code for modern systems. 
• Fixed an obscure issue with file corruption on Save As... 
• Fixed crash issue when adding dimensions from the library. 
• Fixed other 10.13 specific issues.     

 
Version 6.2 (26th September 2016) 
 
New Features / Improvements 
• Smart Snapping Feature: 

o Objects can now snap to each other using smart handles. 
o This option can be turned on and off at any time 
o Snap to centers, edges, corners and bounds. 

• Replaced the Show Size palette with live cursor information: 
o Position information shows on the cursor as you are dragging 
o Size of object displays live on the cursor as you resize 
o Size of the object displays live on the cursor as you are drawing 
o This option can be turned on and off at any time 

• Helper palette: 
o Selecting items in the Tools palette and Dimension palette displays help content in the Helper palette 
o Helper palette displays steps by step guide on how to use the tool 
o The Helper palette includes modifier keys 

• Documents guides: 
o Add document guides from the rulers by dragging them out. 
o Add document guides precisely using a menu item. 
o Objects can snap to the guides when positioned. 
o Guides can be turned on and off 
o Guide snapping can be turned on and off. 

• Custom background and grid color 
• Centered drawing area: 

o Document is centered in the window 
o Zooming is made easier and centers on the document by default 

• Dead Zone feature: 
o The grey space around the document area can now be used 
o Store objects and items in the dead space. 
o Dead zone content is excluded form print. 
o Create bleed documents and full page spreads with the dead zone. 

• Welcome Screen: 
o Take a tour slider, showing all the key areas to look at when learning the product. 
o Video tutorials, links to all the latest video guides, tutorials and lessons. 
o Forum access and link to Register your Product 

• Template chooser: 
o Now choose templates to start with from the main window. 
o Store your own custom templates in My Templates and access them from the template chooser 

• Recent documents added to the Welcome panel 
• Custom preferences for template behavior: 

o Decide how your new documents will open 
o Select custom templates to open whenever a new document opens. 

• Updated interface elements and options: 
o Added steppers in Resize palette. 



o Updated the toolbar and some palette icons. 
o Added new features into the toolbar. 
o Tidied up the View and Layout menu for consistency. 
o Option added for printing background color. 
o New Save As Template… option in the File menu 

• Improved Speed and Power 
o Updated document window with modern window technologies to load faster 
o Improved speed and power from the updated drawing technologies 

• License information is now stored at system level, which means all users on the machine can run the product 
 
Bug Fixes 
• Fixed an issue with text shifting with Print to PDF / Export PDF 
• Fixed an issue where the Dimension cursor disappeared when dragging to scroll the document window. 
• Fixed a load layer bug where a dialog appeared saying the file content could be loaded. 
• Fixed an issue with tools not selecting correctly after the keyboard shortcut has been used. 
• Fixed various document specific issues with content not displaying correctly. 
• Fixed an issue with Parallel Lines options dialog not behaving correctly 
• Fixed various file related crash issues. 
• Fixed zooming issue when using the zoom in and out options from the view menu. 
• Fixed automatic scrolling issues by allowing dragging outside the document using the Command key only. 
• Optimized for the latest operating system. 
• Fixed issue where application crashes when user selects row and columns in Report window and places cursor outside of 

the window 
• Fixed issues with missing Spotlight and Quicklook  
• Fixed issue with size of drawing area being increased if close Print Active Layer dialog while object is in Dead area. 
• Fixed issue where recent documents are restored if Mac is restarted 
• Fixed issue with 3 Point Circle tool. 
• Fixed issue where Zoom-in line weights should not affect selection frame. 
• Fixed refresh issue when switching "Grid Lines" ON/OFF 
• Fixed issue where report is printed incorrectly if increase column width or decrease paper size. 
• Fixed issue when scrollbars do not work in Symbol Libraries dialog 
• Fixed issue when Extrude Parallel Polyline tool doesn't work correctly. 
• Fixed issue with incorrect title being suggested by default in Print dialog if Save document as PDF. 
• Fixed issue by making dimensional text background transparent by default 
 
 

Version 6.1.3 (2nd February 2016) 
 
Bug fixes 
 
- Fixed an issue with Zooming out not zooming out correctly.   
- Fixed window not automatically scrolling when selection or drawing tool is moved down and right.   
- Fixed document not automatically scrolling left or up when using the bezier tool.   
- Fixed an issue with keyboard shortcut reverting a particular tool to the default tool in the tool palette.   
- Fixed Rotate90Left & Rotate90Right toolbar icons becoming obscured by the Title Bar when set as small icon.   
- Fixed rulers flicker when using the scroll wheel on a mighty mouse and when moving objects using the arrow keys.   
- Fixed rulers flicker when the cursor is moved over the Library palette.   
- Fixed issue with Show Size palette are not displaying values correctly for ∆Aº   
- Fixed refresh issue when resizing images spread over several page document.   
- Fixed Fill palette not correctly conveying edited color when set as default in MacDraft preferences.   
- Fixed an issue with copying to clipboard which did not copy correctly.   
- Fixed an issue where objects could not be drawn to the edge of drawing area if rulers were showing.   
- Fixed an issue where objects could not be moved to the edge of drawing area if rulers were showing.   
- Fixed mirrored text getting corrupted when rulers are showing.   
- Fixed Recovery folder with the last MacDraft document appearing in the Trash after shutdown.   
- Fixed an issue preventing certain older files from opening.   
- Fixed arc dimensions shifting when printing or saving to pdf via the print dialog.   
- Fixed a crash bug when adding edit points to an open ended parallel line.   
- Fixed an issue of origin not being moved when rulers were showing.   
- Fixed an intermittent problem where the cursor did not show after returning from customizing the toolbar.   
- Fixed a bug with arc and elliptical arc tool that did not draw an object.   
- Fixed an issue where attempting to move dimension object with arrow key corrupted the object.   
- Fixed a crash bug when grouping certain objects in an older file.   
- Fixed several file specific issues with opening older files..  
 
- Drag and drop to library palette reverted back to Command + Drag & Drop.  

 
Version 6.1.1 (22nd August 2014) 
 



Bug fixes 
 
- Fixed an issue with older MacDraft files not opening correctly.   
- Fixed an issue with clicking in rulers to move the origin where by it did not move to exactly where clicked.   
- Fixed an issue with vertical dimensions on a 6.0 document not showing.   
- Fixed a bug with unit conversion.   
- Fixed a bug with Show Size not working with parallel line tool..   
- Fixed an issue with zooming out using command key where zoom out was not to correct part of drawing.   
- Fixed an issue with GoTo Layer button not working..   
- Fixed a bug where altering the values of radial arcs in the resize palette did not work correctly.   
- Fixed a bug where constrained arcs did not draw correctly.   
- Fixed a bug where report element past certain point could not be selected for editing.   
- Fixed an issue where objects disappeared when zooming and scrolling old MacDraft document.   
- Fixed an issue where MacDraft Symbol Libraries did not open correctly.   
- Fixed bug with Rotate 90 degree tool not working correctly with the Option key.   
- Fixed very obscure crashing bugs.   
- Fixed several issues with rotating patterns and Gradient fills.   
- Fixed minor feedback issues when creating/dragging objects.  
 
- Increased the pattern grid size from maximum of 32x32 to 64x64 in the edit pattern dialog.  
 
Version 6.1 (15th April 2014) 
 
New Features 
 
- Gradient Fills and Strokes.   
- Single Key Tool Shortcuts  
- Star Tool. 
 
Improvements 
 
- Mavericks Compatibility.   
- Ability to create and store new colors, patterns and gradients rather than replace existing.   
- Live feedback when creating objects and whilst dragging.   
- Drag items into the Library without holding the command key.   
- ESC key returns to Arrow Tool.   
- Duplicate Menu has been restructured.   
- Objects drawn using the Freehand Tool can now have patterns and gradients applied to fills and strokes.   
- Other Minor improvements to the interface and speed of the application.   
- Ability to click on the document window title whilst holding down the Command key to show file location path on disk.   
- Support for AutoCAD AC1027 (2013/2014) dwg files.  
 
Version 6.0.6 (9th November 2012) 
 
New Additions 
 
- GateKeeper incorporated to allow running of the app under Mac OSX 10.8 or later. 
 
Bug fixes 
 
- Fixed a bug where grouped objects did not rotate correctly.   
- Fixed a bug where pasting objects containing text across to document/layer at different scale did not paste correctly.   
- Fixed a bug where MacDraft Quit unexpectedly when attempting to add a layer that contained special characters in the name.   
- Fixed a bug where duplicated objects did not move on the same grid as the original object when zoomed in.   
- Fixed a bug where locked objects got corrupted after flipping that had linked dimension associated with it.   
- Fixed an issue where saving to dxf/dwg was not done at the scale of the MacDraft document.   
- Fixed an issue where dimensions read from dwg file were not translated correctly.  
 
Version 6.0.5 (21st May 2012) 
 
Bug fixes 
 
- Fixed a bug where MacDraft stopped responding when attempting to add object after undo group operation.   
- ʻRename Itemʼ is added into the options pop-up menu in the Library Palette.   
- ʻRename Layerʼ is added into the options pop-up menu in the Layers Palette.  



 
- Fixed an issue with Pen Styles not showing in the Option menu under Mac OSX Lion.   
- Fixed issue with export to pdf from DWG files.   
- Suppressed an unnecessary dialog appearing when opening read-only dwg/MacDraw II files.   
- Fixed partial issue with opening and saving of legacy file which crashed MacDraft on subsequent opening of the same file.   
- Fixed minor bugs.  
 
Improvements 
 
- Support for AutoCAD AC1024 (2010/2011/2012) dwg files.   
- Improved functionality in reading of dwg files.  
 
Version 6.0.4 (14th February 2012) 
 
Bug fixes 
 
- File names containing non-Roman characters now open correctly.   
- Fixed an issue where not all the sample libraries were loaded at first launch.   
- Long layer names in the layers palette are now correctly truncated.   
- MacDraw II files now open correctly.   
- Fill patterns in MacDraw II files are correctly translated.   
- Top level folder in the library palette is now correctly named.   
- Fixed the numeration issue of layers after the first layer is deleted.   
- Fixed an issue where drag & drop did not work between documents in Mac OSX 10.6 or later.   
- Fixed a crash bug caused by copying dimension objects in a previously closed document.   
- Fixed several file specific issues where previously saved files failed to open.  
- Fixed an issue where files saved with smoothed polylines failed to reopen.  
- Fixed minor spelling mistakes, abnormalities and bugs.  

 
Version 6.0.1 (9th December 2010) 
 
Bug fixes 
 
- Fixed a monitor resolution problem on a non-apple monitors, where no drawing area was visible.   
- Files created in versions prior to 6 using decimal feet now print correctly   
- Fixed an issue with the Resize palette not showing after switching applications.   
- Parallel line now duplicates correctly after adjusting dimensions and duplicating.   
- Duplicating a dimension on a parallel line and undoing now works correctly.   
- Dragging an object from Library Palette on a large document no longer results in maximum drawing size being 

exceeded.  
 
Version 6.0 (19th August 2010) 
 
This version has various new features and improvements listed below. 
 
New Features 
 
Customizable scales  
Customizable Toolbar  
Library Palette  
Layers Palette  
Image menu  
Feedback for clipped text 
 
Improvements 
 
New Coordinate System  
Increased maximum Drawing size  
New ruler layout  
Improved Resize palette  
Improved Tool selection and operation procedure. 
 
******** 



 
Version 5.6.7 (17th June 2009) 
 
- Fixed bug which caused MacDraft to crash on opening a document created with older version of 

MacDraft that contained imported images.  
 
- Fixed an issue where under certain conditions all new objects created in an older document lost 

their attributes which was caused by corrupted preferences file.  

 
Version 5.6.6 (07 November 2008) 
 
- Maintenance release to fix very obscure bugs and incompatibility issues . 
 
Version 5.6.5 (12 June 2008) 
 
Bug fixes 
 
- Various bug fixes to improve compatibility between files saved on older systems and leopard.   
- Objects exported as dxf/dwg did not align correctly.   
- Objects corrupted after dragging and dropping from Media Assistant Lite.   
- Objects changing color after dragging and dropping from Media Assistant Lite.  
- Not possible to paste from clipboard to MD document object which was copied from Media Assistant Lite.   
- End marks in the dimension palette are not refreshed in new document.   
- After pasting to MD document, objectʼs info is not updated.   
- Angle snap default that was 5 degrees.   
- Hide page break was set to default which should not have been.   
- Object become invisible after creating new document with saved Scale/Units and Layer SetUp settings  
- Documents created in 5.5.x does not show pict/tiff objects when opened in 5.6.x   
- Layer state not preserved.   
- Unnecessary “00” appear when trying to changes number of dwg units per metre after opening dxf/dwg 

file.  
- It is not possible to resize objects with calculated area.   
- Legacy files do not open after re-save.   
- 5.5.11 files re-saved in 5.6 lose custom color.   
- Picture objects not displayed after loading layer.  
 
 
Version 5.6.4 (26 February 2008) 
 
New Features 
 
- MacDraft 5.6.4 has no new features.   
- Leopard compatible.   
- Uses installer to install instead of drag and drop.  
 
Manual Update : 
 
- The MacDraft PE manual has references to functionality no longer supported in version Version 5.6.4 and 

should be ignored. These are :  
 

• PICT or enhanced PICT documents.   
• Saving a document in PICT or enhanced PICT format.   
• Opening a document saved in PICT or enhanced PICT format.  

 
 
Bug fixes 
 
- Various bug fixes to improve compatibility between older systems and leopard.   
- Files created in older version of MacDraft some times do not open or open incorrectly   
- Files, transferred or renamed under Windows cannot be opened.   



- Holding down the control key when dimensioning does not make dimension line hairline.   
- Some fonts are not preserved while transferring Symbol libraries between applications running under 

different operating systems.  
- Old MacDraft File does not open with correct font, even installed.   
- Text in group doesn't restore the correct size after Undo Resize command.   
- Object type isn't refreshed in the Resize palette after show/hide its area.   
- Dimension text disappears when older 4.3 file is opened in 5.6.3/4   
- Object area value will be found while searching for dimensions using Select Special dialog.   
- Adding edit handles to object with displayed area after performing Undo Add Handle causes crash. - Area can 

be deleted when its parent object linked with locked object.  
- Area value is not updated if it was hidden before resizing object and displayed again.   
- Values in edit fields of Resize palette are not properly refreshed while duplicating objects by Cmd-Option-drag.  
- Undo doesn't work properly for meta-polygons.   
- Tolerance text disappears from dimension after zooming   
- Polyline end caps don't work according to the options set in Parallel Line Setup dialog.   
- Ellipses and elliptical arcs are imported with incorrect size from Media Assistant Lite if pasted from non-1:1 scale 

drawings.  
- Default parallel line width is read incorrectly from older format drawings in non-default scales.  
- Distance between the parallel lines not as specified.   
- Text becomes invisible when Text tool popup menu is expanded while text object itself is in  

edit mode. 
- Dimension outline displays incorrectly while drawing.   
- Palettes don't hide after closing document if another one is minimized.   
- Sometimes, pixmap placed in Clipboard from Photoshop causes MacDraft to crash.  
 
 
Version 5.6.3 (19 November 2007) 
 
New Features 
 
MacDraft can now save in various autocad release formats, namely 2000, 2004 and 2007. 
 
Bug fixes 
 
Some minor bug fixes. 
 
 
Version 5.6 (20 April 2007) 
 
New Features 
 
Intel compatibility - MacDraft 5.6 is universal binary and will work on both intel and PPC based machines 
running 10.3.9 and above. 
 
File Format change - in order to bring MacDraft up to date, file format has been changed to give greater flexibility for 
the future so more up to date features can be added. Version 5.6 will open 5.5.x files but 5.6 file format is not back-
ward compatible. 
 
Updated DWG functionality, providing compatibility with AutoCAD 2007. 

(DWGdirect © 2007 by Open Design Alliance Inc. All rights reserved.) 
 
Version 5.5.4 (14th May 2003) 
 
Bug fixes 
 
Undo on a group that did not work correctly  
Freezing bug when scroll full right with maximum drawing size  
Marquee selection that worked incorrectly with smoothed closed polylines  
Grouping of smoothed closed polylines which caused edit handles of object to be at wrong 
locations Custom patterns corrupted on opening MacDraw II file  
Eye dropper tool does not apply object data to groups  
Groups are resized incorrectly using the percent option in resize palette 



Changing line pattern on polygons on reflected in the attributes panel 
Entering of Custom Circle units problem in set scale/units dialog  
Most PICT files don't import at 0,0 Show 
Clipboard minimum size too small  
Invisible Dimensions if the object is at the top of he document 
Grouped rotated ellipses behave incorrectly when ungrouped  
The text display of an angular dimension is displaced after it is linked  
Does not release from the Zoom mode when you Command key click on document 
Elliptical arcs do not display correctly after they have been flipped and edited 
Grouped objects warp in shape when nudged  
Document does not open as saved when document contains part pages. 
Cross hair symbol does not undo if deleted  
Library items dragged out of Media Assistant Lite lose grouping 



Command Click no longer works for terminating spline 
curves Round pen style makes it difficult to move rectangles 
Dimensions extend in symbol libraries  
Print shrink when printing documents created by older versions of MacDraft  
Crash on opening saved symbol library with a group containing arc and radial Dimensions 
 
Version 5.5.3 (19th February 2004) 
 
Bug fixes 
 
1. Fixed a crashing bug when reading old document containing layers with different scales.   
2. Fixed a crashing bug when the clipboard contained data from office application such as PowerPoint.   
3. Reading of DWG files with some constructs is improved.  
 
Version 5.5.2 (17th November 2003) 
 
Cut down version of MacDraft known as MacDraft P.E. (Personal Edition) released for home 
users. MacDraft will now be referred to MacDraft Pro (Professional). 
 
New features 
 
Export Picture - MacDraft now offers the ability to export pictures at the userʼs desired resolution. 
 
Support for Mac OS X 10.3 (Panther) 
 
Version 5.5.1 (10 October 2003) 
 
Fixed very obscure random crash bug. 
 
 
Version 5.5 (12 September 2003) 
 
Only supports Mac OS 10.2.4 and above. 
 
New features 
 
New features have been added to Microspot MacDraft 5.5 to enhance performance and improve image and text 
qual-ity. Features include Quartz Graphics with transparency, ATSUI text, import picture as well as the ability to use 
the resize palette with pixel maps and paragraph text. These features combined make MacDraft 5.5 a superior 
product for CAD and graphic design. 
 
Quartz Graphics - MacDraft now uses Quartz Graphics, the native graphics engine for OS X. The result is improved 
filling of curved shapes, superior line quality that now makes it possible to see the difference between hairlines and 
one-point lines on screen. 
 
Transparency - Transparency has been added and can be applied to lines, fills, double line fills, text and pictures 

with an opacity range of 0-100%. 
 
ATSUI Text - ATSUI (Apple Type Services for Unicode Imaging) text allows for the inclusion of the Unicode 

character set. This maintains superb quality of text even when rotated. 

Import Picture - Import Picture has been added to allow the import of PICT, TIFF, GIF, JPEG/JFIF and Windows 

BMP formats. The pictures can then be resized and rotated to any angle and made transparent. The memory 

efficiency of picture handling has improved resulting in smaller files and faster operation. 
 
Resize Palette - The resize palette now works with pictures and text as well as shapes. 



 
Multiple Undos - 100 levels of undo have been added allowing the user to easily correct mistakes or try variations 

on their drawing. 
 
Compatibility with Adobe Illustrator - MacDraft files can now be made compatible with Adobe Illustrator by convert-ing 

files to PDF using the export to PDF command. The file can then be opened and edited in Adobe Illustrator. 
 
No support for Mac OS prior to 10.2.4 
 
Version 5.1.1 (11 June 2003) 
 
Bug fixes 
 
1. Reading of DWG files with some constructs is improved.   
2. When applying a mirror tool to a ninety degree arc to mirror it about a horizontal line, the widgets appear in 
the right place but the arc itself is misplaced.  
3. A very obscure and only occasionally reproducible crash on opening 1-bit raster images.   
4. Pasting of shape into and then out of a symbol library causes its size change.   
5. Files with text that were created with the PC Draft versions released after February, 19, 2003 are now 
opened properly.  
 
Version 5.1 (31 October 2002) 
 
 
New Features 
 
1.1. Automatic .dwg scaling.   
1.2. Further improved the DWG/DXF import by using the OpenDWG Toolkit libraries.   
1.3. Support for Mac OS X 10.2 (Jaguar).   
1.4. Minor bug fixes.  
 
Version 5.0 (23 May 2001) 
 
 
New Features 
 
1.1. Added linked dimensions.   
1.2. Linked and unlink vertex tool in accessories palette.   
1.3. Further improved the DWG/DXF import by using the OpenDWG Toolkit libraries.   
1.4. Added Balloon help on most menus and tools.   
1.5. Added an angular grid, use the shift key turns this off during entry.   
1.6. Added Navigation services for open and save dialogs   
1.7. Can open Microspot Librarian or Microspot Media Assistant files from the open menu.   
1.8. Attribute popup menus from bottom of window   
1.9. Magnification feedback now has popup at bottom of window   
1.10. Show cursor position area now popups palette menu   
1.11. Option close closes all documents   
1.12. Select layer tool hilites when clicked to show you are in that mode   
1.13. All previously modal dialogs made movable modal   
1.14. Can show areas on Metapolygons   
1.15. Can resize groups by X and Y as well as percent in the resize palette   
1.16. Added crop marks if required to edge of printed paper as Dreams used to   
1.17. Move Object dialog has Apply button as well as Move button   
1.18. Cross hairs when resizing objects if cross hairs are turned on   
1.19. If you double click a file in the Finder will bring that document's window to the front if it is already open.   
1.20. Save grid snapping values in preferences, especially if grid snap is set to none   
1.22. Duplicate with control key down will now not duplicate locked objects. 
1.23. Control-option-click with arrow tool selects layer of object clicked on.   
1.24. Option key down on entering dimensions toggles format to 'arrows inside'.   



1.25. Control key down on entering dimensions make the dimension line a hairline.   
1.26. MacDraft 5.0 files are interchangeable with PC Draft 4.3.5 and later.  
 
Palettes 
 
2.1. Added a new Alignment Palette   
2.2. Attribute palette shows current settings   
2.3. Attribute palette has new parallel line fill which can be hidden with zoom box   
2.4. Arrow head popup menu selects whole line if cursor in middle of line item and draws with correct feedback   
2.5. Dimension Palette now has zoom box to hide bottom items so can be used on a 640x480 screen   
2.6. Symbol library palette and window now moved in unison so that switching between modes does not cause 
palette/window to move around the screen unexpectedly.  
 
Menus 
 
3.1. Added Palettes to Windows menu   
3.2. Added option to Tile and Stack Windows   
3.3. Expand and Contract object menus  
 
Tools 
 
4.1. Repeated paste tool   
4.2. Edit Datum tool   
4.3. Rotate tool   
4.4. Hand tool   
4.5. Inclusive and exclusive marquee selection tools   
4.6. Tool Options menu item   
4.7. Eye dropper tool works with parallel fill attributes   
4.8. Eye dropper is now undoable  
 
 
Drawing 
 
5.1. Created 3 line types (square, blade, and round)   
5.2. Can now draw double lines off double lines without having to break up first   
5.3. Bezier has rubber deletion facility of freehand polygon   
5.4. Bezier gives feedback with mouse up. Also only shows first and current bezier tangents   
5.5. Backspace deletes last point of polygons, splines or beziers   
5.6. Shift key unlocks constrained lines on entry   
5.7. Shift key constrains Rects, Elipses and Rounded Rectangles when resizing   
5.8. Calculate arc bounds differently if filled or not filled   
5.9. Pictures and text can be flipped   
5.10. Pictures support no fill option and filled backgrounds   
5.11. Curved dashed lines now drawn much better.  
 
Text 
 
6.1. Text services at bottom of Text menu for spell checkers and grammer checkers   
6.2. Text can be vertically aligned   
6.3. Text size now up to 1024 point   
6.4. Text size menu now reflects the selected text   
6.5. Text popup menu off text tool   
6.6. Zoomed in small rotated text drawn MUCH better   
6.7. Select a rectangle and start typing inserts a new text object. Rectangle is automatically linked to this new text 

object.   
6.8. Click on selected text object to start editing   
6.9. Handles work on caption text tools to resize font size   
6.10. When changing scales, any text objects can either be scaled or not.  
 
Bug fixes 
Arrange menu in Layer dialog did not work first time   



1. Now saves document and palette window size and position if saved on second screen   
2. Now zooms document and palette windows correctly on multiple monitors   
3. Show area menu greying has been corrected   
4. If show area on an object, the info palette showed nothing   
5. Holding shift key down AFTER editing bezier straightens handles   
6. Command click in Edit datum mode exits that mode   
7. Command click with eye dropper and marker tool goes back to arrow tool   
8. Dimensioning did not print on a second page of a high res printer   
9. Area fills were missed out after certain lengths on a high resolution printer   
10. Corrected inaccuracies in bounding rectangles   
11. Metapolygons calculate extents correctly   
12. Speed up in redraws   
13. Linear duplicate framed a rounded rectangle when clicking two directions radio button   
14. Edit Datum only greyed in when one object selected   
15. Resizing polygons left ghosts if you had smooth text on.   
16. Zoom line weights did not differenciate between 0.75, 0.5 and hairline if zoomed in.   
17. Dashed arcs and circles draw MUCH better.   
18. Easier to select an arc segment when zoomed in.   
19. Find/Replace. The replace with Use mouse will not find items with a blank string   
20. Duplicate with no offset will not move view at high magnifications.   
21. Do not unconstrain angle constrained lines unless user types in a different angle.   
22. Added "including original" text into the copies item in the linear and circular duplicate dialog   
23. Removed 'by center' and 'by datum' radio buttons in duplicate dialog as did the same thing   
24. Document Shift Page Up and Page Down does Page Left and Page Right.   
25. Using the arrows keys after a duplicate now updates the duplication offset for further duplications.  
 
 
Version 4.4 (7th January 2000) 
 
New Features 
 
Made MacDraft MacOS 9 compatible. 
 
MacDraft saves and reads PCDraft exchange format. 
 
MacDraft reads and writes DWG files if the DWG File Exchange library is present. 
 
Export file command in File menu using QuickTime Graphic Exporters to save as JPEG, BMP etc. 

Selecting New from the File menu selects New Document. 
 
Added Register and Upgrade Information menus items in Help menu. 

Added Command U back to Ungroup. Command-Shift-G is still valid. 

Command-Shift-D duplicates with no offset. 
 
MacDraft requires a serial number that matches the version. 
 
The Reopen Application Apple Event implemented so MacDraft will open a new document if no document is open on 
double-clicking the application in the Finder. 
 
MacDraft will now read future versions of MacDraft files but not display unknown objects. They will be saved back 
when written back to a file. 
 
Bugs Fixed  
Fixed overflow bug which resets to origin when zooming out from a large document at a large scale. 
 
When zooming windows on multiple monitors, the window will zoom to the size of the monitor that it is on, not to the 
main screen. 



If saving a document which is not on the main monitor, MacDraft will now open it again in the correct position and 
not on the main monitor. 
 
Added 'open' and 'kind' resources. 
 
Grey out Select All Text menu if entering text. 
 
Does not crash after reading DXF files. 
 
 
Version 4.3.1 (29th July 1999) 
 
New Features  
The MacDraft PDF documentation can now be accessed from within MacDraft using the system wide Help menu. 
 
Improved Functionality  
DXF importing is now much more robust and able to cope with files created with Revision 14 of the DXF 
specification. 
 
Opening files (especially PICT) is now much faster. 
 
Bugs Fixed  
Fixed a crashing bug that could sometimes occur when opening a MacDraft Symbol Library. 
 
When creating PICTs (either via the Clipboard, Drag & Drop or saving to a PICT file) the colors of objects saved in 
the PICT were subtly different to those in the original document. This meant that if that same PICT was later re-
imported into MacDraft, those colors would probably not match 'equivalent' colors in MacDraftʼs standard color table, 
and hence could not be selectable from the Fill or Pen Color pop-up menu. This problem was compounded by the 
following bug... 
 
MacDraft documents saved with additional colors to those in MacDraftʼs standard color table would lose those 
colors when the document was reopened. Items that used those colors would then be drawn in black (or random 
colors). This and the previous bug have existed in all versions of MacDraft since at least version 4.2.2 (and 
probably earlier). We are amazed that they have gone unnoticed for so long. 
 
Version 4.3v4 (30th April 1999) 
 
Bugs Fixed  
Fixed a crashing bug that could sometimes occur when opening a MacDraft Symbol Library. 
 
Version 4.3v3 (10th August 1998) 
 
Bugs Fixed  
Fixed FAXstf™ conflict. If the user cancelled the FAXstf password dialog that is displayed after choosing Print 
from MacDraft, the program would sometimes crash. 
 
Version 4.3v2 (1st July 1998) 
 
New Features  
Added 'Select Arrow Tool' and 'Select Zoom Tool' menu commands to the Palettes submenu. Their command key 
equivalents are Command-` and Command-Shift-` respectively. These commands can also be assigned to a 
Short-Key of your choice. 
 
Improved Functionality  
ShortKeys menu. As well as assigning commands to the function keys F5 to F15, you can now also assign 
commands to Shift-F5 to Shift-F15.  



E.g. To assign a command to Shift-F5, press Control-Shift-F5. 
 
(This feature was actually present in MacDraft 4.3, but was never documented anywhere. Congratulations if you 
had already found it.) 
 
When opening documents which use unavailable fonts, MacDraft now retains the original font information for text ob-jects 
unless the user explicitly changes it. Although any text using missing fonts will display incorrectly, if the document is saved 
and then opened on a computer where the font is available, it will display correctly. To determine if a docu-ment uses any 
missing fonts look at the Font menu; missing fonts will be displayed dimmed above the installed fonts. 
 
Bugs Fixed  
Fixed crashing bug when attempting to use Command-key equivalents of some menu items when no documents 
are open. 
 
MacDraft is now usable if you have no printer driver chosen. 
 
When doing free rotations in minutes or seconds it now possible to step back to degrees or minutes using the 
Com-mand key. This feature went missing in MacDraft 4.3. 
 
When opening documents saved on other computers, MacDraft could get confused about which fonts to use, even 
if the same fonts existed on both computers. 
 
Version 4.3v1 (June 1998) 
 
This version was never released externally. 
 
 
Version 4.3 (17th April 1998) 
 
There are many improvements and new features in MacDraft 4.3. For a full description of these, please read 
the printed ʻUser Guide Addendumʼ. 
 
The following is a brief description of the main changes. 
 
Existing users who wish to get started straight away should, at least, read section 7 of the addendum for 
important changes to the Command-Key equivalents of MacDraft. 
 
Late Breaking News  
This section deals with features that are not mentioned in the addendum, or have changed since it was printed. 
 
The addendum refers to a sample Librarian file called ʻFurniture Libraryʼ; this file has been renamed to 
ʻMacDraft™ Libraries Samplerʼ. 
 
Added a Close All command (Command-Option-W). This will close all of the open MacDraft document windows. 
 
The Align command has been renamed to Align Again to better clarify its meaning. This command allows you to 
align objects using the settings previously defined in the Alignment Options dialog. 
 
New Features  
Drag and Drop support. Objects can now be dragged in and out of MacDraft document windows, both from 
other MacDraft windows and other applications. 
 
ShortKeys Menu. This menu allows you to assign your most commonly used menu commands to the function 
keys (F5 - F15). 
 
Rotate 90° Tool. This new tool allows a quick means of doing 90° rotations to the selected objects. 



 
Attributes Tool. This tool allows you to copy and apply attributes in the same way as using the Copy Attributes and 
Ap-ply Attributes menu commands. 
 
Marquee Zoom. The zoom tool now allows you to drag out an area to zoom in on. 
 
Cancellable actions. Most drawing actions (ie creating and modifying objects) can now be aborted using Escape or 
Command-Period. 
 
Improved Functionality  
Improved layout of many alerts and dialog boxes. 
 
Alignment Options now supports a wider range of options. 
 
ʻCommand-Clickʼ shortcuts that were used to exit the current drawing tool have been removed. You can now use the 
new Escape or Command-Period keyboard shortcuts. This now allows the Command key to be used to temporarily 
turn off the grid snapping while using the drawing tools. 
 
PICT support has been dramatically improved, MacDraft documents saved as PICT should no longer lose any infor-
mation(*) when reopened in MacDraft (assuming that they haven't been edited somewhere else first). Full MacDraft 
PICT compatibility is required, as it is used by Drag and Drop for external data.  
(*)The two known outstanding exceptions to this are - Areas and Point to Point dimension lines. Areas will lose their 
links to the parent object, and Point to Point dimension lines will be broken into Text and line objects. We will be ad-
dressing these problems in a future release of MacDraft. 
 
The icons used by the Finder have been improved and now include small versions. (You may need to rebuild the 
desktop database to see the changes, by holding down the Command and Option keys when the Finder launches at 
the end of startup.) 
 
On-screen display of rotated text has been improved to remove unwanted visual artifacts. It is also drawn up to twice 
as fast as previous versions. 
 
The state of the Absolute/Relative mode in the Move dialog is now remembered for subsequent openings of the dia-
log. 
 
Preview images are now added when saving in MacDraft or PICT format (requires QuickTime™). 
 
The standard Open dialog supports file previews (requires QuickTime). 
 
MacDraft now makes more use of the systemʼs Temporary memory to reduce the chances of running out of memory. 
 
DXF reading code has been improved to better support files from PCs. Please see the separate file for further DXF 
info. 
 
When auto-scrolling a MacDraft window during a drawing operation, the maximum scroll speed is now pinned to 
something more manageable on modern computers. 
 
The Escape key can now also be used in places where Command-Period is used as a means of cancelling. 
 
Invisible files are no longer displayed in the standard Open dialog. 
 
The selected format is now remembered between uses of the Open dialog, and it has been defaulted to ʻMacDraftʼ 
instead of ʻAllʼ. 
 
The pattern editor can now be used on 16 and 32 bit monitors. It has also been enhanced. 
 
Saving files (especially PICT) is now much faster. 
 
Bugs Fixed  



Fixed crashing bug under Mac OS 8 when the System Wide Appearance setting was off. 
 
Now disallow any shapes that have an attached 'Area Calculation' from being added to other shapes. Previously it 
was possible, using the Add Tool, to add a shape that was showing its area - this resulted in the area becoming de-
tached from the original shape (which in fact had been deleted) and the program would crash if the area was clicked-
on. 
 
Opening MacDraft 3.0 files that contained an empty text object caused a crash when the object was part of a group. 
 
Switching between the different Unit Standards often resulted in objects being the wrong size. i.e. something that was 
drawn as 1" in decimal inches did not get changed to 2.54cm when the units were changed to Metric cms. There was 
a similar problem when changing from decimal feet to another units setting.  
Objects pasted between documents with different 'Unit' formats are now scaled correctly - this was not always 
the case previously, especially when one of them was using decimal feet. 
 
Paper sizes were being calculated wrongly for some printer drivers (especially the ImageWriter). 
 
Numerous minor bugs have been fixed. 
 
Eliminated all known memory leaks 
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Disclaimer 
 
MICROSPOT LIMITED, its distributors and dealers make no warranties, either express or implied, with respect to the in-
formation contained in this document, or its fitness for any purpose. This information is made available only on an "as is" basis. 
The entire risk as to its quality is with the customer. Microspot Ltd. its distributors or dealers are not liable for direct, indirect, 
incidental, or consequential damages even if Microspot Ltd. have been notified of errors in this in-formation. 
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System requirement. 
Minimum system requirements : 10.8 and above.  
Recommended RAM : 2GB 


